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Introduction 
 
AEMLog is a data analysis package designed to be used in conjunction with 
AEMPro. AEMLog offers many advanced analysis features including 
overlays, histograms, XY plots, maths channels, lap analysis, track drawing 
and channel alarms. AEMLog runs under the Windows 95/98/NT/XP 
operating systems. 
 
 
 

Documentation 
 
This User Guide is split into two main sections. The first, Getting Started, 
contains instructions on programming and reading data from the logger and a 
brief overview of many of the AEMLog features. The second section, 
Reference, discusses the features of AEMLog in detail and outlines the 
methodology behind installing and calibrating sensors for use with the logger 
and the use of AEM beacons for lap timing purposes. 
 
Throughout this guide, procedures in AEMLog are referred to using the menu 
commands separated by a | symbol. Thus File | Open means select the Open 
command from the File menu. If a keyboard shortcut or a button on the 
AEMLog toolbar also performs the same task, this is shown in the left hand 
margin. 
 
A comprehensive on-line help system is provided with AEMLog to give more 
details on using the package. To view the help, press F1 or select Help | 
Help Topics. 
 
Help can also be obtained in dialog boxes by clicking on the ? in the top right 
hand corner of the box and then clicking on the item for which you require 
help. 
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Installing AEMLog 
 
• AEMLog is supplied on CD-Rom and automatically installed when 

AEMPro is installed. To begin, simply click on the AEMLog shortcut that 
the install placed on your desktop. 
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AEMLog Quick Reference 
 
The following sections give a brief overview of options and menu commands 
available in AEMLog. For more information, see either the on-line help or the 
Reference section later in this User Guide. 
 
 

The Main Graph Screen 
 
The following screenshot shows a typical AEMLog graph screen with areas of 
interest marked. 
 

 
 
 
 
 
 

Placing the mouse 
over a marker will 
show the time and 
date when the 
marker occurred 

Allows scrolling 
through a 
zoomed in graph 

Shows current 
graph settings 

Moving this bar changes 
the size of the values are 
and changes the font size 
as necessary 

Shows values of 
each channel at 
current cursor 
position 

If the graph is in 
overlay mode, 
clicking on the y 
axis cycles 
through all the 
axes scales fo
pl

r that 
ot 

Many of the commands in the Graph menu are reproduced in the graph popup 
menu. To view this menu, right click on the graph itself. 
 
To zoom in on the graph to view the data in more detail: 
 

Keypad + • Select Graph | Zoom | In. The cursor will change into a  showing that 
you are in x axes zoom mode. 

 

• Click on the area of the graph where you want the zoom to start. 
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• Click on the area of the graph where you want the zoom to end. The graph 
will be redrawn with the new zoom range. 

• The selected zoom range is bounded by red vertical lines at the start and 
end. Using the scroll bar at the bottom of the graph, data outside this zoom 
range can be viewed. 

• If there is data outside the scrollable region, a  or  will be shown at the 
edge of the scrollable area. These will shift the zoom area to the left or 
right respectively. 

 
The y axis can be zoomed in a similar manner by selecting Graph | Zoom | 
Expand which will change the cursor to to show that you are in y axis 
zoom mode. 

Ctrl Keypad 
+ 
 

 
 

Menu Commands 
 
The following section gives a brief overview of the menu commands and their 
use. If a tool bar button or a keyboard shortcut can be used to perform the 
same function, it is shown in the left hand margin. 
 

File Menu 
 
The File Menu contains all the commands used for file management: 
 
Open F3 

 • Use the open command to open a log file. 
 
Reopen 
• Allows a file to be selected from the most recently opened log files. The 

down arrow next to the open button can also be used to reopen files. 
 
Export 
• Exports data in an ASCII format suitable for use in other applications such 

as word processors or spreadsheets. 
 
Abstract 
• Copies selected channels into a new data file. 
 
Notes Ctrl F3 

 • Displays notes about the current data file and allows new notes to be 
added. 
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Exit 
• Quits AEMLog. 
 
 

Graph Menu 
 
The Graph Menu contains commands used for displaying and printing graphs. 
 
Graph Ctrl G 

 • Invokes the graph options editor where the number of lines, overlays and 
lap markers can be specified. An example screen is shown below 

 

 

Sets the number 
of distinct areas 
plotted on the 
graph 

Allows overlays 
to be specified 
with the overlay 
setup editor 

Set the channels 
to be plotted here

Click the draw 
button to draw 
the graphs 

 
Overlays 
• Allows the graph overlays to be set. 
 
Setup 
• Edit edits the setup of the currently active graph. (Note that this is different 

from the currently active setup). 
F2 • Update Log File saves any changes made to the data file. 

  
Shift Overlays 
• Allows the x axis of any overlayed Files to be moved relative to the base 

graph x axis by dragging the plot. When in shift mode, the cursor will 

change to a . Click on the graph and drag the overlayed plots to a new 
position. 
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Zoom 
• Allows zooming in or out on the x and y axes. 
• In Zooms in the x axis. 
• Out Zooms out the x axis. 
• Expand Zooms in the y axis. 
• Contract Zooms out the y axis. 
• Normal Resets all zooms. 
 
Plot Types 
• Time or Distance: Plots the graph against time or distance (if recorded). 
• Real or A-D: Plot the graph using real (engineering) units or using raw 8 

or 16 bit data. 
• Standard Plot or Lap Plot: Allows the lap plot facility to be switched on. 
 
Tape Measure Ctrl T 

 • Displays the Tape Measure window. This allows the difference between 
two points on a graph to be measured. 

 
Insert Marker 
• Inserts a Custom Marker at the current position. 
 
 

Analysis Menu 
 
The Analysis Menu contains commands for examining the data in more detail 
than possible via a simple graph. 
 
Lap Times F5 

 • Use to display lap markers, split, total lap times and average lap speed. 
 
Statistics F6 

 • Displays minimum, maximum and average values of channels. 
• Double clicking on a minimum or maximum value will automatically zoom 

the graph around that point. 
 
Histogram Ctrl F7 

 • Shows the frequency of occurrence of values in a channel as a percentage 
of the current zoom range time or distance. 

 
XY Plot Ctrl F8 

 • XY plots allow one channel to be plotted against another thus allowing the 
relationship between the two channels to be explored. 
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Templates Menu 
 
Graph templates allow frequently used graph plots, graph types and window 
positions to be saved. These can then be recalled at any time by running the 
template from the menu or by assigning a button on the toolbar to the template 
and clicking on the button 
 
Save 
• Saves the current screen layout and graph options as a template. 
 
Run 
• Prompts for a template file name and then runs the specified template. 
 
Configure 
• Configures toolbar buttons for use with saved templates. 

 
Maths Menu 
 
AEMLog allows mathematical formulae to be applied to recorded data 
providing for much more complex analysis. Once maths channels have been 
created, the calculated data can be plotted and analysed like any other channel 
and can even be used in other maths channels. 
 
Maths functions are stored in a Maths Library. This central repository of 
maths functions allows libraries to be shared between users. 
 
Note that the maths channels reference recorded channels by the name of the 
channel. Therefore, for maths channels to work consistently, an effort must be 
made to ensure that channel naming is consistent over time. 
 
Open Library Shift F9 

 • Opens and existing maths library. 
 
Edit Library F9 
• Edits the currently active maths library 
 
Recalculate Ctrl F9 
• Adds maths channels to the currently active data file using the current 

maths library. 
• Added maths channels can be displayed and analysed just like recorded 

channels. 
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Merge 
• Combines two maths libraries. 
 
Create 
• Creates a new maths library. 
 
Calculate On Open 
• When checked, maths channels are calculated when a data file is opened. 
 
Calculate On Read 
• When checked, maths channels are calculated when a data file is read from 

a logger. 
 
 

Config Menu 
 
Logger 
• Specifies the type of logger AEMLog is being used with. The logger type 

affects certain areas of the setup editor. This needs to be set to DLOG99. 
 
Options 
• Allows options such as PCMCIA slot mapping and graph colours to be set. 
 
Tool Bars 
• Some or all of the tool bars can be turned off if desired. 
 
Close On Read 
• When checked, all existing data files will be closed when a new file is read 

from a card. This can be useful during a logging session that may result in 
the potentially confusing situation of many windows being open at once. 
Opening files will not force other windows to close. When not checked, 
existing files remain open when a new file is read from a card. 

 
Notes On Read 
• When checked, the user will be prompted to enter notes about the data file 

whenever a new file is read from a card. 
 
 

Window Menu 
 
Tile Vertically 
• Arranges windows vertically with all windows visible if possible. 
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Tile Horizontally 
• Arranges windows horizontally with all windows visible if possible 
 
Cascade 
• Arranges windows in a cascaded format with each window on top of the 

previous one. 
Minimise All 
• Minimises all windows. 
Arrange 
• Arranges iconized windows. 
Close 
• Closes the active window. 
 
The numbered list at the foot of the Window menu can be used to make the 
desired window active. 
 
Cascaded windows appear on the screen diagonally, from upper left to lower 
right, overlapping so that the title bar of each window remains visible. 
 
Tiled windows are distributed to each corner of the screen, so that each 
window is visible and none overlap. 
 
Icons (or reduced windows) appear at the bottom of the AEMLog main 
window. Each icon remains visible. Double-click an icon to make that 
window active. 
 

Help Menu 
 
Help Topics F1 

 • Display the Help Topics dialog box: 
 
About 
• Display program version and serial number information. 
 
To find a topic in Help: 
 
• Click the Contents tab to browse through topics by category. 
• Click the Index tab to see a list of index entries: either type the word you're 

looking for or scroll through the list. 
• Click the Find tab to search for words or phrases that may be contained in a 

Help topic. 
 
Context sensitive help can be obtained by pressing the F1 key. 
 

Analysing Data - 11 



AEMLog User Guide 

Help can also be obtained in dialog boxes by clicking on the ? in the top right 
of the dialog box and then clicking on the item for which you require help. 
 
 

The Scalars Table 
 
Scalars are used to calibrate raw data in the form y= mx + c, where y is the 
real data, x is the raw data, m is the multiplier and c is the offset. Scalars are 
combined with Inputs in the Output page to create the recorded outputs. 
 

 
 
The Name column specifies the name of the scalar 
 
 

Real = Raw × Multiplier + Offset 
 
The Min and Max values define the lower and upper limits of the y axis when 
the data is plotted. See the Calibrating Sensors section for more details on 
setting up the scalar and function table. 
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 Function Tables 
 
Function tables are used to convert a non-linear sensor output into linear real 
data and are entered into the Functions page of the setup editor. An example 
function table page is shown  below: 
 

 
 
The Add and Delete buttons can be used to add or delete function table 
sensors. 
 
The Name box is used to specify the name the function table. 
 
The Gain column specifies how the raw data is stored as discussed above. 
 
The Min and Max values define the lower and upper limits of the y axis when 
the data is plotted.  
 
Clicking on the (…) button displays the function table editor: 
 

 
 
Use the Insert button to add another entry or the Delete button to delete an 
entry. 
 
The Input column contains the raw values.  
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The Outputs column contains the real values.  
 
Once the function table has been entered, click the x button to return to the 
Function Table page of the editor. 
 
Function tables calculate the real value by looking up the raw value in the 
input list and matching it to an output value which is multiplied by the 
multiplier. Linear interpolation between nearest sites is carried out if 
necessary. See the Calibrating Sensors section for more details on setting up 
the scalar and function table. 
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Analysing Data 
 
Once a data file has been opened, data can be viewed and analysed by several 
means in AEMLOG, each of which will be considered in detail below. 

F3 

 
 
 

Simple Graphs 
 
The simple graph allows channel data to be plotted against time or distance (if 
recorded). A typical graph screen is shown below: 
 

 

If the graph is in 
overlay mode, 
clicking on the y 
axis cycles through 
all the axes scales 
for that plot 

Allows scrolling 
through a 
zoomed in graph 

Placing the mouse 
over a marker will 
show the time and 
date when the 
marker occurred 

 Shows values of 
each channel at 
current cursor 
position 

Moving this bar changes 
the size of the values are 
and changes the font size 
as necessary 

 
 

Shows current 
graph settings 

 
 
To alter the graph settings, commands from the graph menu are used. Many of 
these commands are reproduced in the graph popup menu. To view this menu, 
right click on the graph itself. 
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To change the lines plotted, choose Graph | Graph and the graph setup editor 
will be shown: 
 

 

Sets the number 
of distinct areas 
plotted on the 
graph 

Set the channels 
to be plotted here

Click the draw 
button to draw 

 

Allows overlays 
to be specified 
with the overlay 
setup editor 

 
Overlays can also be added from here by clicking the overlay button. 
Overlayed channels can be from either the existing file or from additional 
externals files. Up to four external files can be added; when plotted, overlayed 
channels from external files are preceded with a number corresponding to the 
file number in the overlay list. 
 
Overlays from external files can be shifted relative to the base graph by 
selecting Graph | Shift Overlays. This allows starting points of data to be 
easily synchronised. 
 
To zoom in on the graph to view the data in more detail: 
 

Keypad + • Select Graph | Zoom | In. The cursor will change into a  showing that 
you are in x axes zoom mode. 

 

• Click on the area of the graph where you want the zoom to start. 
• Click on the area of the graph where you want the zoom to end. The graph 

will be redrawn with the new zoom range. 
• The selected zoom range is bounded by red vertical lines at the start and 

end. Using the scroll bar at the bottom of the graph, data outside this zoom 
range can be viewed. 

• If there is data outside the scrollable region, a  or  will be shown at the 
edge of the scrollable area. These will shift the zoom area to the left or 
right respectively. 

Keypad - • To zoom out to the previous zoom level, select Graph | Zoom | Out. 
  

• The y axis can be zoomed in a similar manner by selecting Graph | Zoom 
| Expand which will change the cursor to to show that you are in y 
axis zoom mode. 

Ctrl Keypad 
+ 
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Ctrl Keypad  
- 

• To contract the y axis to the previous lever, select Graph | Zoom | 
Contract. 

 
The right hand side of the graph shows the values at the current position 
(shown on the graph by a vertical black line). This position marker can be 
moved by clicking the left mouse button on the graph and dragging the bar 
whilst still holding the mouse button down. Alternatively, the left and right 
cursor keys can be used (holding the shift key down whilst pressing the cursor 
keys will move the bar ten times as fast). 
 
Clicking the right mouse button on the values area of the graph will show a 
menu allowing line colours, style and y axis limits to be changed. This menu 
can also be used to add boundary lines for highlighting ranges on the graph. 
 
The y axis labels of the graph show the real or raw ranges of the graph. If a 
particular plot has overlays, the axis limits will show the current percentage 
range. By clicking on the y axis, the y axis labels will cycle through all actual 
channel limits for that plot. 
 
The functions available from the Analysis menu will now be considered. 
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Statistics 
 
The statistics screen displays the minimum, maximum and average values of 
all channels in the base graph over the current zoom range and the times at 
which these occur. Double clicking the mouse on the time at which a 
minimum or maximum value occurs will zoom the graph in around this point. 
An example statistics screen is shown below: 

F6 
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Histograms 
 
Histogram shows the frequency of occurrence of values in a channel as a 
percentage of the current zoom range time or distance. Choose Analysis | 
Histogram to show the histogram setup editor: 

Ctrl F7 

 

 

 

Condition which 
must be met for a 
value to be 
added to the 
histogram 

Channel for which 
the histogram is to 
be calculated 

Number of bars the 
histogram is to be 
split over 

Additional 
conditions 

Set whether the 
bar ranges are to 
be calculated 
automatically or 
specified 
manually 

Sets the start and 
end bar ranges if 
in auto range 
mode 

 
Set channel to the channel for which the histogram is to be calculated. 
Conditions can then be applied to the histogram to limit the amount of data 
included by checking the When box and entering the condition desired. Up to 
three conditions can be specified and are combined with the logical operators 
AND, OR, NOT. Only values that meet the specified criteria will be included 
in the histogram. The number of bars to plot and the bar ranges can now be 
specified. 
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Once the setup is complete, click OK and the histogram will be drawn: 
 

 
 
Once a histogram is drawn, the histogram editor can be re-entered by right 
clicking on the histogram. Once a histogram setup has been created it can be 
saved to a histogram template by clicking the Save button in the histogram 
editor. Histogram templates can be assigned to buttons in the histogram editor  
by selecting Config | Options and entering the filename in the histogram 
buttons page. 
 
 

Analysing Data - 20 



AEMLog User Guide 

XY Plots 
 
XY plots allow one channel to be plotted against another thus allowing the 
relationship between the two channels to be explored. To create an XY plot, 
choose Analysis | XY Plot; the XY plot editor will be shown: 

Ctrl F8 

 

 

 

Channels to be 
used for the X 
and Y axes 

Channel 
conditions 

Sets the size of 
the plotted 
points. 

 
Set the X and Y channels for which the XY plot is to be draw. Conditions can 
then be applied to the plot to limit the amount of data included by checking 
the When box and entering the condition desired. Up to two conditions can be 
specified and are combined with the logical operators AND, OR, NOT. Only 
values that meet the specified criteria will be included in the XY plot. 
 
The point size changes the size of the plotted points. On plots using a large 
amount of data, a small point size should be used. However, when the data set 
used is small, a larger point size helps to show any trends in the data 
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Once the setup is complete, click OK and the XY plot will be drawn: 
 

 
 

By clicking and holding the left mouse button on the graph, the mouse can 
move the cross hairs on the plot. The X and Y values at the current cross hair 
position are shown in the status bar at the foot of the graph. 
 
Once an XY plot is drawn, the XY plot editor can be re-entered by right 
clicking on the plot. XY plot settings can be saved in an XY plot template by 
clicking the Save button in the editor. XY templates can be assigned to 
buttons in the editor  by selecting Config | Options and entering the filename 
in the XY plot  buttons page. 
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Maths Channels 
 
AEMLog allows mathematical formulae to be applied to recorded data 
providing for much more complex analysis. Once maths channels have been 
created, the calculated data can be plotted and analysed like any other channel 
and can even be used in other maths channels. 
 
Maths functions are stored in a Maths Library. This central repository of 
maths functions allows libraries to be shared between users. 
 
Note that the maths channels reference recorded channels by the name of the 
channel. Therefore, for maths channels to work consistently, an effort must be 
made to ensure that channel naming is consistent over time. 

 
Defining Maths Equations 
 
To show the maths library editor, either open a maths library using Maths | 
Open Library (Shift F9) or edit the currently active maths library using 
Maths | Edit Library (F9). Note that AEMLog always sets the last opened 
maths library as the currently active maths library. The currently active maths 
library is shown in the AEMLog status bar. 

Shift F9 
 

 
The main page in the maths library shows the maths equations currently 
created. The Name column shows the name of each equation and the 
equation column shows the actual equation. To create a new maths equation, 
click the Add button and enter a name for the equation. By clicking on the 
(…) button next to the equation, the equation editor is invoked. 
 
The equation editor allows the maths equation to be entered/edited. A typical 
equation editor window is shown below: 
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• The equation will appear as it is entered in the top left edit window. 
• To add an output to the equation, ensure Outputs is selected in the Object 

box, then click on the desired channel from the list displayed. 
• To add numbers, +, -, /, * or brackets, simply type in using the keyboard or 

use the mouse with the keypad displayed to the right of the Maths Editor. 
Note: no operators have precedence in the Maths Editor: i.e. 1+2*3 will 
evaluate as 3*3. Use brackets to change the evaluation order: i.e. 1+(2*3) 
will evaluate as 7. 

• To add a maths function, ensure Functions is selected in the object box, then 
click on the desired function. 

•  If Auto Range is checked, values for the Minimum and Maximum range 
will be automatically calculated. 

• If  Auto Range is not checked, values for Minimum and Maximum cane be 
entered. The Min and Max values 
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Adding Maths Channels 
 
To calculate maths channels for the currently active data file, choose Maths | 
ReCalculate or press Ctrl F9. A window will appear showing the progress of 
the maths calculation. Calculation can be stopped at any point by pressing the 
Cancel button. Once the maths channels have been added, they can be plotted 
and analysed like any other channels. 

F9 

 
The maths evaluator automatically adds any channels in the currently active 
maths library that have their required channels recorded. Any maths channels 
that do not have the required outputs recorded are not added. The record rate 
for the maths channels is determined automatically from the rates of the 
recorded data. 
 
Note that the maths library matches channels by name…channel naming must 
remain consistent over a period of time for the maths library to remain 
universal. 
 
AEMLog can also be configured to automatically calculate maths channels: 
 
• If Maths | Calculate On Open is checked, AEMLog will attempt to 

calculate the maths channels whenever a file is opened. 
• If Maths | Calculate On Read is checked, AEMLog will attempt to calculate the maths 

channels whenever a file is read.
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